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Importing jobs into the print queues

Print files by importing them directly to the Fiery server. You can import multiple jobs at a time and maintain the format
of the files.

You can import multiple jobs at a time. Importing files to a queue is similar to printing through an application, but
importing files maintains the file format and does not convert the job into PostScript. You can import files by dragging
and dropping them to

¢ Connected Fiery servers in the Servers list
* Processing queue
¢ Held queue

However, for the best control over how files import, use the Import icon in the Job Center toolbar, or the Import Job
in the File menu. You are immediately taken to the browse dialog on your computer. When files are selected, they are
displayed in the Import Files dialog. In this dialog box, you can easily apply a workflow (server preset or virtual printer)
to files at the time of import. Generally, you cannot do this when you import files by dragging and dropping (the Servers
list is the only exception to this rule).

1 Drag and drop files or folders from the computer to the Printing or Processing queue, or the Held list.

The supported file types are PS, PDF, PSD, PSB, EPS, TIFF, PDF/VT, PPML, ZIP, VPS, and Fiery FreeForm Plus.

X% : The PSD, PSB, PPML, ZIP, and VPS file types may not be supported for all Fiery servers.

The Import Files dialog box does not display when you drag and drop files or folders to these locations. The entire
contents of folders are imported.

2 Drag and drop files to a connected Fiery server in the Servers list, Processing queue or Held list.
The Import Files dialog box is opened. See step 5 (50 ~—37) .

3 To import files directly from your computer, do one of the following:
¢ Click File >Import Job.

* Click the Import toolbar icon in Job Center.
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4 In the browse dialog on your computer, select the files you want to upload.
The Import Files dialog box is opened.

5 Do one of the following:

* Select Apply default settings to import files with attributes defined in the files. If a setting is not defined, the
default setting on the Fiery server is used.

 Select Use Server Preset and then choose from a list of factory default presets or server presets that are currently
published on the Fiery server.

e Select Use Virtual Printer and then choose from a list of virtual printers that are currently published on the Fiery
Server.

The Use Server Preset and Use Virtual Printer options above only appear if server presets or virtual printers have
been set up on the Fiery server.

6 Select a job action. For example:
o Hold (default)
e Process and Hold (default)

» Send to Press/Send to Print Queue/Send to Ready to Print
Other choices may appear based on the capabilities of the Fiery server.

X E : The last chosen action will be displayed.
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AEIVTARL— b AZ a7 OBKIZAY X, Fiery Y AT LY 7 b7 =7 FS150/150 Pro A TH R — h &
NTWET,

BITRAML—bAROTIV U EBSKICAVELTI—TT S

I<KHEAFT LT AP L= su sz P Z2BRICAD ELTy—27 3512, ROWTANEITVE
D

o ZURNUEBEBRLT, V—AR—DOBRICAVEZ Y v 7 T5,

o YT RIML—I AT NIEEZY 7L, VA MOLERICAY ZRINT 5,
YTA ML= X u s M) ORICENETREINET,

YITAML—bAZOTIY M) ZBRICAYDSHIBRT S
BRUIZAVELTvy—7 LI MU ZHIBRTE £,
RONTNPEITOET,
o VY bN—DOBRICAVE7 Y v 7T 5D,
e U RNVELEIZ YL, VA RDPOLBRUICAYZI VT 5,
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Ja7DTOANTA T 4 v RO THHAARERFRKY A T 3T AL — X207 OBKICAY 2R R TE
i‘a‘o

HBITAML—FAZOTOBKRICAVICDOWNTDH
VT AL = O 7OBKIZAVIZ, ROBEBRIZIZEHINETA,

PTARNL— I Ea IOy AR— |k
Fiery ) YV —ABIORED NNy 7 T v FHETAT v a v

AE I AVR—F>BBFEER—TVEMFEHLTCH T A ML — ¥ a7 Y % Fiery server |28 53 %
&L BEEOBRUICAY BMRFFSILET,

YITXML—bAROT7IY M) ZFERLTNSY 3 TDERR

EBERBEEEITL HFEOY T AN L — X0l NI REALTWATRTOY g T —EHRHRTX
3

1

e

Command WorkStation TiZ, —_"—17 ¢ > RUTIRTDI 3 T%2 27V v 7 LET,
TRTOF2—DFTXTOTa 7N, $T_XTHOYVa T a— Il —EFRRENET,

Vad BT~y ZEE7 ) v L HEEBM> B> TN —MAROTDERIZEIR L £7,
YT AR — B ZaZOLFIN, Va Tl —EDT LNy ZICERINET,
VL SN—T, FOMT 4N EZ—DRICHEEAZ 27U w7 LET,

BRITAIWEZ—DHAZIA XV AT, YTAML—bAHZOTD&FIZERL, RELZ2 ) v/ LE
¥

YITAML—bAZATDRF 7 ANV Y —DIZHDRAE 7 Vw7 L, MBERYTARNL— xR
TR EBRLC, @R Y v 7 LET,
BRI T A PL—bhZn sy P EEHLTH LT RTOYa 7R —RFERINET,

F7a T, REEZZV 7 LT, BEEREZ 22— LTREFELET, RERERZE 21— LTRE
WZ4RTIEAD L, REEZZ Y v 7 LET,

2= NP —=NRN—= 4V RUDOF 22— A MO TR RFINET,
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YIZXAML—bAROYT

YI7AML—bARATIV N ZEETS

VAT LEBEIL VT AN — b u s N 2ER EEF 2 ITHIFRTE £9°, Command WorkStation
6.7 BETIL, T 74N OV —NR—RETHILEL, WONTNNIZED Y THENTWAEATH, 7
ARb—hthxurszr ) BREFZITHIRTE 9,

e Va7’
e 7TUtv b
s TV H—

BEDY T AL — b Za 7 F)Z AL TWATRTOY a 72FRTHIL, EERBREEZFITL
F9, FFMCOWVWTE, YT A ML= X2 M) EAEALTWAY a TOMmE 215 X—) 25K
LTL7Z&EW,

YITRAML—bAZOTIY M) ZERTS

MfFon s n 7y M) 2 BRIUARZERE T2 T, filtnzs P 2fERTEET,

1 BTAML—bAZAT V4 RUT HRT L0 MU EZBRL, VA N—DEBE 7Y v 7 LET,
VEIZRLT, = MV EA7 Y vy L, EREEIRLET,

AE::—EFiZ1o0=y NPT ER X F,
2 BRI AT SRy 7 AT, = hYDHLWARTEZ AT LET,
3 K7V vy 7 L TERLEZHRFLET,

BRINIZY T A — b AFn 72 PR BEIINCERENET, 20T MU EBRL, LEIDSL
ThhomMtEZiRETE £,

YIJAML—rAROTIV M) ERETS

BTA ML —btHFn T M) OFEESEERETE ET,

1 Y7 ML—bAROTY 4 RUT, ROWVTRDEITVET,
e TURNUEERLT, V—AR—DFEEZ 7Y v 735,
e BIRLIZ U NV ZBE TN Y v T D,
o TRLIZZ U NV ELZ Y w7 L, fREZERT D,

1O EDT a7 N T AR — 42 M) EFHLTWDZEEZBENTDHA v E—URERRE
hi‘ﬂ—o

2 7R —brhFa sz M) RRICEEMT O TWDES

o Va7, FUky b FETFY L E— FFTIANNOY—RN—FE 1 DU DY a TR T
o= a2 PV EFEALTWAZ L EZHBATIA v E—UNEREINET, A vbB—UnFE
RENESL, OKZZ7 Y w7 LET,
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3 MERERETFRAN T A=V NICANT DM FRIFRAIZZ Y v 27 LTRMDO Y X h 2R LET,
FLWBMREZIBIRT 270, I3 LW EHEEZ AN LET,

AE DHMUBIEICRR S T2 A LTl o EIEICBEIT 5 & Mo W IMURMEIT O EEICR Y %
R

4 OKz27 Vw7 LTEREEZRFELET,

AE T CUFa—lChdVa 7OEAE, Va TR ERFARILED . YaT70Ta T U4 K%
PANT0 35 & AREMSINT v 77— b ShE T,

HITAML—MAZOTIY M) EZYIBRT S
HIRXAML—bbAHZOT T 4 RUT, Y7 AL — b Za s b ZHIBRTE £9,

1 YIJZAbL—MAHEOT Y 4 RUT, HIRTAY T AL — A Z a2l v A2 ZARDOIBIRL
T,

WL TWAEHEOT o MY 2BIRT 551 Shift F—A2 LN 7 U v 7 L, ik L W nERo
T MY EABBIRTASESIICul T—2 LN 56270 v 7 LET,

2 ROWVTHNOHTIET, BIRL7z= B U Z2HIBRL £,
o VN N—DRIBFEZ Y v T 5,
e BIRLI U FUELZ Y v o L, BIRRAZRIRT 5,
3 #7AMLV—FAZuTTy N PNROERIZEEN TN TWDLSHE

e Vad ULy N RETFY L E— FLET TN IOV —N—FE 1 DU O g TR TR
o=t Xl NI ZERALTWDZ E2BMTDHIAvE—UNEREINET, A vE—UNRE
mENEH, OKE 27 Y v 7 LET,

YTAML—bBE2a Tz N EHIRTDE.FO M) FYa TICEEM T ONRL RN ET, Va T
DODTaRT 474 RYTIE, Y TA ML — ¥l A NMIKREREFRREINET,

YITAML—bARATIV NI ZI 3 TICEIVETS

P72 K L— kB F 1 Z 1 Command WorkStation DY 3 DT ONT 14 7 4 v RUNLBHATE £7,
1 Va7 z@ERL, ROWTNNEITNET,

o TUTVAVA=a—0bTONTAE 7Y v LET,

o TaTvxrAsZ Vv LTTANT A ZRIRLET,

o VaATdEVE—Y—AR—DTANTATAarmE ) v LET,

o VaTdEXTINIV I LET,

2 V37070 TA4 T4 FUT, EUMORKS 72270 v LET,
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3 HJARL— Fﬁ&mﬁ)XF#6#72FVMFEVFU%@RLiﬁo%iyk) W REEAHT B
YT AR L— MEMEEHERT IR, BIRRX 227 v LET,
#7xbv—bﬁ5m7i/b) JDéT%ﬂt%%xnm% HAXIDV A MIERENET,

4 BB YA ADOID ZRINT 50, FAXIDYARDLHAZ LY A RERETEET,

AEIHVTAML—bARZOTEBIOYAXID Y A MNOT L RV IE, TA7 7y MEIC-ERRENE
ﬁ‘o

—BNEARZ LY TA ML= A XZEIVETS

YT RA R — MR RAZ DY A X B Y THZENTEET, Va i 72— A&y
TR B Y THBICHEA NS, ERFLY A X2 BIRTILETHY A, T AR L—MIH A
B DA X aEN0 B TEHBRE, VA AW Z 0T THAZ LY A ZOFHRT L B 25T 248 ITH Y £
Poo —BERIR T ZZ DY A ADPRITSEODIT BEDY 7 X b L— R XOMHN 1 ERY - 13RESH
TWHHETT,

1 Par7&ERL, KOWVWTNNEITNET,
o TUVIAVA=a—bTANTAE7 ) v LET,
o YaTvxAI7 Vv LTTANT A ZRIRLET,
o IVTEUER—Y—AR—DTOANTAT A E IV v LET,
o TaTZEXZTINIUvILET,
2 37070744 RyT, EMORBES7E22Y) v LET,
3 $T7AML—bAZATIANPEL, REELZRIRL LT,

4 YITRXAML—bYARXT7 4=V T, HRAZLHZ 27V v 7 L, 3T AL — DB AZ LY A XEFREL
£,
ZOHAZLY A XTI TA ML= FA XY R MFRENET,

XE I HAZ LY A XOTIETFRNRLEDOT, VA XD X JIZERBINTWAE YA XD I3k
SNFEHA,

HIJANL—bI R

YT A=t hZa T ) BERERIIRET AR, S ESERT T A ML —NEMRRECTE E
T, ATz FUDOYT AL — MNEHERET DI i'&71hb fAZOTDOAAL T 4V R E
FIMRE Y s PR LES,

ANBUEDRIETLFIOBITER (*) BDERSNET, ANPLEOBIED T 4 —L Rid, ZEDOEEICT
xEH A,
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YIXAML—bAROYT

TFTARNL—= b BEa T TE, RO2FEEOV T A R L— NEEty ERIELTWET,
« 7 Ur%— (PPD) %

4% PPD 5% € CFon S D3RI, 5t L T D Fiery server D PPD IZ K> TikEV £,
* JDF (Job Definition Format)

JDF JEMEIIFEARETH V. Bt L TV D Fiery server (K17 L £ A,

HERRENE

AT LEBFE T, PPD £ 721X IDF BEEEOY T A ML — A a sl N RERR TR ET, A B
L—hthxua sz b OERICEE S 7z PPD BRI Z L IC® ey $£9, £o7=H, PPD BIEDHE
LEESETT,

ROV T AN — b axuar7x M) 2887 556135, 7 PPD ¥ELORRE £ /213 JDF ¥EHLOFR T % &
WRTHZVERHY 9, 5OV TE, YT AL — MO0 R EZERT D 211 X—) 2K L T
<TZEV,

PPD MEHLOGRE 21BN 2 &, BIENKRDZ TITFRRENET,

o % (219 ¥—Y)

o HA X (220 %—2)

o WIT—RE (220 2—2)

JDF LD E 2 RINT 5 &, BYENRO Z TIZFERRSNET,

o % (220 %—Y)

o ZOfEME (225 X—)

o HAX (220 —)

o WT—HIE (220 X—)

WO FUTHEE LT EE W,

o AKX (220 —V) EHT—FHE (220 X—°) (X, PPD & E & JDF % E DM 5 IZH@ TT,
o BEMAIL, BEH L TWAD Fiery server THAR— FENTWDEHDIZE > TRARDZGAENRH Y £7,
o BMEOBBTIL, THM F1EL AT 47 WO AL 7 A L—1b) 2HELET,

—f&4%2 7 (PPD ZE#L)

e FkZHT 2020 7o ) ORI L4H  hZa 7o R IZ
FEEDOLRIZATILET, ZD7 ¢ —/L KX, PPD EM: L JDF Bt
T BT,

JE&x AROESZI 7 ey (um) BALTHEELET,

2AT Va7 OEEISU THEATE A S F I EREEO RS - EERE

nEJ,
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FNA AHEIEO IO E T, CIE L*a*b*i ch 7 — % EEL £,

S 2 AR O E H & BMOFEM, 72 & 21X, 'Hammermill Color
Copy 10246-7 8 1/2” x 11" 105 g/m2 Photo White Ultra Smooth| &V>9 &
D 7RI LET,

YA X427 (PPD & JDF DA DHEICHIE)

YA X ID

AL X HhERay
YA R
HEE A5

YA XTI Za TP LEIRS N AKOY A X2 R LET, 1 XD I
Fiery server CHEJIZAR SN E T,

it T RE 70 TE Fe 9 A IR A XD —Fa T4,
T 2 RO A ANRRRESNET,

W DI T A N — bR END FMERELET, ROA T3
YINHEIRL £,

o TL:TT74E,

o FBID ROV T A b L— F BRI S D BRI,

o RID:WAIOVT A b L— FRBR SN DO,

"G, 7TAT7TLa—F, @Eha— e RSN AT 4 7ICH

T WA T THY, FRASNL—X =2 Lo TFET, £720%
Management Information System (MIS) (2L > CEFRINET,

AS—RES T (PPD & JDF @5 DFREICLLIE)

B ThS—Tar7r A

HhSs—Jou7ry A

—&% 7 (IDF ZEH)
Al

B
GRS

AOB L CHICOLBMAINDET 74V OHT—T a7 7 AL T
T, JaJo7anNT4 >hAS—>BATAaT77AIVTEH LWG T —
TuT7rANEERETLE. ZOBMITEEXSNET,

FAMOBEBICOREHAEINDT 74NV DA T—T a7 7 A4 )L T,
JaJoTanNT«a4 >hAS—>HBATAaT7 AV THR LWL T —T 1
T ANERETAE, ZOBMITIEETEINET,

FRZT 2020 7o ) OGR4 hZu 7o FUIZ
EEOAHIZATILET, ZDO7 14—/ RiX, PPD EM: & JDF B ]
FiZFHE T,

il 19~ 2% FIAR ORI i & BN O FEA,

TDF v IRy T ANF N o TWAES . FRICIZEIRIE DN
BREENTNDZ Ea2RLET FREARDO LS —~y RBOWfE



2AT

Hih

TIAF ¥

% (FHERER)
hI—%

AAR LTI T —%h

HiWl 72/ ay—

BLT:

51T

Fiery Command WorkStation | 221
YIXAML—bAEOYT

), TOF v IRy T ANT TR TWAEATE. Bk
FIRIE A DR NN 2R LET,

FERTAHMDA by 7 XA THFTERLET, ROLT T g onbiE
IWLET,

o FRHE . EEOHHEE O AT,

o FBHAYV—b oV X AT SEHO OHP v — h T,
FEEESEAE R, T AR Ny 7 24 T OMOFEMZ R LET,
FEIEZEAD (224 X—2) BT &N,

HEBMEIL, EHT2HAMOEREZFH A — b Hiz ) O 7T KEAL
(gm?) FFAR R (b) ZHALELCELEYT, HE (224 2—)
ERIBLTIEEN,

AT HRORET 7 AF v ZRLET, 77 AF v (223 ~—)
ZZRLTLTEE N,

MR E EN L HEROLR (S—k h),

DA 7 —CTF, LHHORKERRET I, (2071 ho7—F
Tra v EBERL TN,

DD AR LT T —TF, NT—A=a—ICBHDON T —INERE
NARWVEEIX, ZDT 4=V RICHAZ LT T—DA4RTIZ AT LET,

ERTE LT 7 ) v o — 2 @R £,

s FTUtv b @RETV—bEMEALT KTV M) A A-VEA
DR E T e — T —ITIRE L&, Y7 A FL— MIHIR L £,

o L= kR TL—¥—) ZHALTT A MA A=V EH T
A bL—MCBEELET, ZO8A FORRITE, b F— kT4
L2 — R LT 7 A b L— MCEIRIL 2T,

o AT TYN TV E—D ) XA 7R B L CEIR
LET,

OB CTHICEATEARETT, BHLT 221 %—V) 25 L
TLIEE W,

FAROEmICHEHATEHORETT, £ 222X—) 2R L TES
W, BETEERCF v /Ry 7 2% 4720, A—T4 V9. YR
B, FIRBJREE O A 7> a v O BINT A Z LN TEX F7,

B THEBICIE, Ao s TICEMATE 2ROBIERD D £,

WRDOF T a ORI LET,

a—+

Aokt ClHoa—7 4 JORETT, a—F 2223—) %
SZHRLTL &N,
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Y& TS EOMETY T L EIT, BB Tl T2 0ES
T, KEOEGOMEMNRKENE, BN KENWZ EE2RLET,

i 2 FRIS S w2 e E L £

By R, AOEICEATE AROBHERH D £3,

BECmeRU

a—+

p 1N

FIVk v fiE

a—F

BLTCU 4 FUTBRLAERELFALRECLETS, BHT (221
R—=V) EBRLTIESN,

A { Fiery server Ti&, BETHEERUENRT 74V MZleo TV E
T, BETEHERILF 2 v/ Ry A4 7L, A—TFTa4 7.}
B, ENRIATREEBIED A 7Y a v O hn b @IS 5 2 2 b T
ﬁqo

FIMOEmICEE SN a—T ¢ o VOfEYIEE LT,
a—F (222 %—2) BB LT EEN,

Sz 75 EOMETY Tl L &I, MRER TRIT 2 0EE T,
B OEGOERRE L SEREBRENZ L 2R LET,

A A=V EHBT S HE 2 EELET,

a— MEthix, AfCERT2Rma— oI A T2RLET,

WRDOF T a ORI LFET,

L

a— MK

JEiR

R

<v bk

Y5y

S IRIN

a—7 47 eEALEE A

FE—V U TRIEFEAL T, FEAER, ROLNEI, BEAREDH
A RRICE 2 9,

O E IR —T 1 T

Bk L2170 3 Toa—7 4 7ORTRUERBH Y £,
ZDa—=T 4 U ZIIHEFITRI RS Y — TR 2 B L F
‘a—o

ORNIFEAELRWIEIRT, 179y b ELMERENET, Zo=
—T 4 7T, HROEZBND LT Enb o £,

KRNI NIRa—T 4 TV EL  ~y ba—T 4 7 L0 5
K70 FET, BT7—1F o &Y LEECITHBICHIBI S N E T,

FHRL~VE IR a—T 47 e~y ha—T 4 7 OIRIEPHI
MBLET, 20a—F 4 73 vy —FREGELZFERLET,
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77 AF v @ME, BHT 2 HoORET 2 AT v ERLET.

ROF T a s PHRIRLET,

TITA—T
AL B LT
av v

IR
Iyl

YRVIVERA

7zl b
LAk
A4 av o)
DR

pRIN

<o oA RT

AT 4w T

AL—F
A—IN—R L Z—{L BT
A—IN=AL—X

RENINT L LY HWME ETIZR>T0ET,

T ARTAL—=RAETHORMH LIEa— METT,
OREIZ & SPIRD Lb Z AT 4L P T,
FRLORD 720 2 — METT,
KEMINDRD X 5 RBAR DTN AL BT T
Fem LR D A2, = AR A M T BT,

IvMETFE D 26 —T A—/IN\—ALVE—LEIF L vl
EFoFEE T,

ik 7 =)V NI TAL BF T,
T L ACERO S5 —> (FZ AR Off LI T,
JvZINiFED LoD, ESERO Lbax bofth BiF T,
REVHMEOMAOT 7 AF ¥ & b ottt BIFTF
RO BHE EF T,

TI AT AL=RERFORH LIFa— METT B ATV vy
28D HHVE RTTY

TR HORD 72 IS RAT: T T,
AR O BT,
FRAMUAL TSl e R ot B T,

BT ML 72 A b— X7 R AL B P T,
DENTHENE EF TR, RSL LV ELNTT,
BRI T2 2 b= R BLIR A BT,

eIV S WARVAS i il ol A G I

P 722 M BT,

A xT— R 72 A B — R e At BT,
RHAL—AT, Fbov0bHHIEa— METT,
WMot B s, JIVE S RALA—X LD HigHNTT,
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LA RED BIAB AT F— DT % BEEROM BT,

MO 72 ME BT TR, A—/IN—RAL—RIFEELNLTIEH Y £H
Mo

ML ORD NI Ea— MEET T,
RN BT,

ALy NS W B 23R BEYEIRAE BT,
FZoNL WOt BT,

MEREAIRMEIL, T 2R by 7 2 A T OFMRREZ R LET,

WRDOF T a ORI LFET,

BRI

R— )UK
MRt (B

Mgt GREMen)

S 2avi%

]
feln

ZOF T asFk A Ny 7 BRI A VLT E LR WEAIT
BIRLET, VAT AL TI,. Z2OF 7 a »OIRENRVLADE
ERHY FTH, L OEEIITEEREEHTAHRETL 0T

Va IRETAOLEIIH Y FHA,
BAR— I bEH S AT,

YA KK - TEL S NIRRT - THEKEHIC DR A > 72— b
1R D ANFEARRRT,

PA RN Ko TERSNFLITH » THEGEIZ OB > T2 — b
B R D ARHEARRT,

=L DT LT,

EEBMIL, FHA— MBIV DT T LEBA (gm2) £723RCF (Ib) ZEALE LTRENET,

KD LA b v 7 B A FOIEARERIL, R REAL (b) TEINET, HAIZ gm2 8T 5
Wi, EAREEIC, USSR AR LT,
72EZIE S0R FOBond A by 7 DESZ7 T METERTIZIZ, ROHREZITHET,

FEAEH & x ZBHURE =50 x 3.76 = 188g/m2
FHEA b v 7 2 A 7 2L DERREICHONTIE, ROEZBRLTIIEEN,

FIRER by 2 2T BHLRH
Bond 3.76
Ledger 3.76
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R Ny 7 24T BRI
Thin (manifold, onion skin) 3.76
Duplicator 3.76
Safety 3.76
Uncoated book 1.48
Coated book 1.48
Text book 1.48
Cover Papers 2.70
Index bristol 1.81
Tagboard 1.63
Blanks 2.28
Printing bristol 2.19
Wedding bristol 2.19
Blotter 3.08
Label 1.48
Newsprint 1.63

ZDfDEMESZ T (JDF ZE4L)

M3

JE&

&

JL—K

k= b

FARRO YK F R TI, EIX 0% (IREEER) 205 100% (EE=R) 0%
FHCHRELE7,

MEDESZI7vy (ym) BALTHREL £,

HAMEIOEEZRLET, 1I~5DOL L THEELET, /L —F (226
N=) BB LT &N,

FVAEITT Y X —IHRT D OB 7 +—~ v &R L
9, Afftz=v b 226 3—) 2L TLEEW,
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CIE Lab 71 5— T ZFEEAFO RO G TT, CIE L*a*b*HTH 7 —ZHE L £7,
Fita)g (CIE) ARARY BT AR TEHHEN D, R L 2O RE2R L&

T, BHTEIX. CIE © xyz FEEEEIC X AECTHRE L £3, (100, 100,
100) DFEEAEfEIL, ERREGEZRLET,

74~k (CIE) ko Hsr, FEfafn, IFECOESNERLET, KO Tint fiix
CIE O xyz FEAZEfE A L CHRELE4, 0 OFEEMIZ, Ly -7 —
VEI TGS TH DI EERLET,

ANEW g RBWHEBIEIIHBEOBHAL L E R LET, RBEWHE (227 2—)
EHRBLTLEE N,

ABEWEE L ~N)V% FRDORBHE TT, 0%IT52 2 EH. 100%1% WCARBHTH D Z
LERLET,

JL—F

(7L —F) BHEIIAREROEZ R LET, I~5DL~ L THRELET,

XE I ZoRMIZ. TUXAHIMOEAITEEEA L EE A,
FERTOIMERD D5E1E. WOTA RTA A>T I,

JL—FK ARoORERE

1 JEIR = — MK

2 ~v ha— MK

3 FR=— M (m—)1)

4 JFa— MK (H)

5 Fa—rE (FF=271)
Bff1=v b

A=y MathiZ, 7V AFERITTY) V¥ —IZHRT 2RO y—~ v 2R LET,
WDOF T a N HERLET,

o—F 1A 1 K> B ENTHTT,

a—) Lk A RTEE T BB EEH T,

Ut Pro 7ol EnTdlEik (77 7+ —/L FiK) T,
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FERE

NG E BV OB L~V 2 )T b D TT,
ROF T a s PHRIRLET,

AEW FI/ AT 4 TOARBABREAICEIR LEST, 20X A 7O AT
S 7T WA L CHBFEITEmAE T TR LEH £
Mo

B N7 T4 VEROE I I 2BHALMHAL TERTH D X 5 7
AT 4 T EERTHAIER L9,

=W TRTCOBPASLET CERRZ TWA AR/ AT 4 7 2T 5254

T oAx T o EBIRLET,

YITRXML—bAH2OT7ZEETS

VAT LEBENY T A= A n T EREBLOERL £,

YT AR — " DRl EZHRETHE, TITAR—FLED, BIOVT AL — D ZFulb~vw— L0,
R DT 7 40 M2y FLIED T2 2N TEET,

HIRAML—bAHROQTETIIVRAR—+T3
BT AN L— "B E a7 AR—FTHE, xml 77 ANE LTRESH, WOTHLY T AR — B &
07 VR—FTEET,

BT AR — R NIEZ R T EBEXRZ LA, FTEIEVAT LAY T NI 2T 2HA VA M= 500, BIEDOH
A AR—FLTHIOBRRICANy 7T o7 L TRIZEEZRBEDOLET, 2 M) A2 AKR—
F20, 78y 227 AR—"TEHENEBIRTE 7,

1 YT7XAML—bARAT T 4V RUT, V= NR—DIVAR—b27 Vv 7L, INCIVRAR—+%
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‘a—O

3 TIVAR—FEINET7ANDLRIEANNILT, F#EEZ7 V7 LET,
YT RARb— bW Ea e AR—F T5HE, xml 774 VE L TIRESNET,



Fiery Command WorkStation | 228
YIXAML—bAROYT

BYITRAML—bALOTZBERZS

VAT LAEHEIL. TLWT A R—2 5 A VR— LT, BEFEOV T A ML — MR T EEE DL
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AE I HAREOF 74N MIA T T, Ya T ora T o EHHREOT 740 M2 By NI,
TIHIVNEREV 4 FuTcty b2 20 v 7 LET,
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A EHTESY a 7% EIL. Fiery server DET /ML - TR Y T4,
o R=URE- 7L Ea—X=U¥ A XDRR, KADOHE (17— "—BLOY a 7HERIIRAONMA
WEEENET), I T7—A A=Y (WK ORRREEZETTEET,
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Set Fiery ImageViewer preferences

For color jobs, you can specify Fiery ImageViewer preferences such as units and monitor profile.

The image size (dimensions) and resolution are displayed at the bottom of the screen.
1 Select Edit > Preferences (Windows) or ImageViewer > Preferences (macOS).
2 Set any of these preferences in the Preferences window:

¢ Units - Sets the units for displaying the dimensions and resolution.

« 'Clear' Separation Display Settings - If the Fiery server supports a clear varnish separation in addition to C, M,
Y, and K separations, use this setting to specify Mask Color and Opacity of the clear separation as shown in Fiery
ImageViewer.

 Cross Hair Color Picker - Click the color block to select the color of the bounding box in the Navigator pane.

e If Fiery Color Profiler Suite is installed on your computer, you can click Create a Monitor Profile to create a new
monitor profile in Fiery Monitor Profiler.

» Reset Preferences - Resets the Fiery ImageViewer preference settings back to their default values.

» Image Border - Click the color block to select the color of the border around the page as shown on the substrate
in the image preview.

e Front - Click the color block to select the color of the border around the document size as shown on the
substrate in the image preview.

» Non-Imageable Area - Click the color block to select the color of the translucent fill for the non-imageable
area, for example between the imageable area and substrate, as shown on the substrate in the image preview.

e Press Inspection Zone - Click the color block to select the color of the border for the press inspection zone on
the page as shown on the substrate in the image preview.

« Ink Limit for Animations - allows you to manually adjust the value that represents the total ink limit (which the
default value represents) and highlight pixels that are close to the limit such that an edit made from Fiery
ImageViewer can warn you of the pixels that have exceeded the limit.
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